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1. Controller Tester E}Zl A E 7}0|E

CodeScroll Controller Tester& AI2510] EIZIS E|AE SH= ALIE2| 25 AHEHL|CF

Texas Instruments Code Composer Studio
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1.1. Texas Instruments Code Composer
Studio

1-1. CodeScroll Controller Tester Z2HE S MM SHL|C}.

CodeScroll Controller Tester RTV(Remote Target Werifier) + Target Plugin (x64)

D EBE(E [M) ZEEEP) BN HAEM &0 E2UH)
ME SS71N) > AA MY C/Ces TEME
=eil(e)] Ctrl=W § @ C| = (CodeWarrior, Green Hills, NEC) C/C++ ZEHE
HEY ASC somE
IS Clsshiftayy | & HIFE AROQ C/C+s Z2HE
B 7= CodeScroll ZEME HEE C/C++ ZEHME MY
HES) Ctrl+S _ _
_15! - tfl CPl IIYUERE C/C+s ZEHE MM
& MEE Ctrl+Shift+S B 5 HESSE Cc.. ZERE Ak
0|2 Ht372|(M)... F2 |[E] RIV 9E C/C++ ZEEE
M= 2H71F) FS g RIV 2C SE0j ¢/Ces ZERE
AI=HOI= BEIW).. [ 22 B C/C++ Et7) BAE SERE
pag  FHE2700)... Y QHICIE(CodeWarrior, Green Hills, NEC) C/C++ EfZ! B|AE ZEHE
i WEW?IO).. B @C MEZYE C/Ce+ B2 BAE ZEWE Mo
E4(R) Alt+Enter % ZIEHO)... Chrl=h
Z2(X)

>
L

1-2. 43t CCS toolchaing MEHEHL|CY.
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Z=HE 0|F:  [CCStest

& BN | C:#ct_workspace

EH M=
= e il 22
CCS toolchain
O GCCa
[l W52017
| V52019
] GCC 4.7 (32bit) TEOE MAE|SISLCH
O GCC 5.3 (32bit) ThE2E SADisLD
J Microsoft Visual Studio 2010 (32.. AS2E MAMEAUSLCH
O Microsoft Visual Studio 2010 (32... AESZ MMESi=| |t

<oz@ | osmw- [ 2E@ |
1-3. | AESH AA IS MEFHL|CY.
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B yz==ms O x
M EzmE
=4 IS JEHUAIZ,
21449 CI20E|2): | D:#ocs_workspaced 1 2. Trest | mor=71@)..
LIEEE ote
v [ 12.7test EEEEEEE |
Jaunches -
seftings main.c
Debug
targetConfigs
24 e S5 HAE oy
ZOrE7|B)...
A4 MU B2S I JW RAE LESLLL HAR)
170 55 A\ SLT
= 0|EiB L2 = 2= Ha
ST MM DF 02|10 ARE S5 TRHET HNELIC
o ey  Target Plugin (s6d - o =
A[22m B ESEM B
e -u:éz g7 ll'.:-'ﬂ 2% srar @ Y@ (2 St i
HNE TR EAWT FreeE Smone [Daw ) #EsRmn A0 2808 Eragoms heszwas Tes
' B E main.c A gaE Ly A - |
W 345534345 ] T8 Awam
s L 1/0/0)1 100.0%
int main(veld) .
o = el B4
200 TYPEZ And T } - a3 #HEax
200_TWREZ_Rewd CT_copy | B LI

» g CCStest
 (ljg Datauit Moduke
w L manc
& man
B dededed
g
W
wn
0 test
W teiccs
1 Temtitt

[~ 1 ] i Bl

Bl Eas By

u B HEHEY 670 YA,

2. C|HHHE AtE3SH?| {5l CCS, CodeScroll Controller Tester 0| A
Texas Instruments Code Composer Studio C|H{7{ AL2 7}0|E

100.0%

28s gt
27

o
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3. CodeScroll Controller Tester 2| f{E T2HE =22l > EM > EHI HAE -> EHZ &HE0|M AH S 5HOF

= A =
U Ct

3-1. W &Y

Texas Instruments Code Composer Studio 81E 70| & 211

AlGH El
B costest 4 o ®
TE HAE gF Epl HIAE 43 A HAE ICE Wooa 2@, = v
24 Ga
- » TI P C2000 b 6.2 b TMS320F28x b ide Ef2l 53 7197
v Et2l HAE ot
Bl =z T
HAE 24 | | OIF i
e cexml_path Diccs_workspacest1 2 Test#targetConfigs#TMS 32072808 coxmi
@ script_path
SIEr target_binary_path Diccs_workspaced1 2. TrestDebug1 2. Ttest out
debug_probe Spectrum Digital XDS560V2 STM USE Emulator
Cpu_name Cadxx
memary_page Memory.Page. DATA
char_format 5.
0|2: [ehar_format |z (@
E2! | memory BT Al character
format IDZLULIC 7|23
252 M0 23,
device®] IS 17 B8 OE
0| 8 = gy
HEFE7 Ha
AlSH EH
« Ao Ef
I 2 AHE Ol mM2AE AMA Qlol| Qlo =20
CCS Z=HE F=20f Y= Z2HE 23 TrZYLCt. O] T2l 0|§2 CCSOf
M2 5 o (e]] IT fe) = (] Sl0|5
M 25t EIZIC| O|SYLICH Z2HE H=0} EfZIQ| 0|F0| =] &elgt
ccxml_path

C}.
Ofl: {project_path}\targetConfig\{target_name}.ccxml

: M3 ASYET TR MU Al BRE Y (OW U5 YotE
script_path
LIC})

CCS YE A| M E| = outO}UC| HAZ 0f:

target_binary_path ) i
{project_path}\Debug\{project_name}.out

debug_probe?| O|Z, CCS properties AtZI2| Device 222 (G| A|2] AFRIO|AM

debug_probe o
= Spectrum Digital XDS560V2 STM USB Emulator)

cpu_name cpul| O|E, CCS properties AFZIQ| SIEE (0| A|2] AFZIO|M= C28xx)
memory_page CCS2| memory_page, CCS Memory Browser AtZI 2t

CCSQ| G|0|E{ XLBH = character®] &=A. AILIO2EE{ 12 A|2F Ol|: character
char_format 7} Sl BHO] AFCHO|MSE] 5HRO]| YO, char_format 240 52 {5101 &
L|C}.

* CCS properties
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Debug

debug_probe Cpu_narme

Device §Spectrum Digital XDS560V2 STW USE EmulatoriC2 8]

+ CCS Memory Browser

== Disassembly O Memory Browser 2 v e i
Data ~] [oxo03r100
Data:0x3fb100 - 0x003FB100 <Memory Rendering 1> &

Character A
8-Bit Hex - Tl Style index: 0 X . . . 0 i - - K z k
8-Bit Hex - C Style index:1 " k W X e
8-Bit Signed Int  index: 2 e T T .
8-Bit UnSigned Int index: 3 ..y 0 .2 . = x v . 7 .

-Bit Bi index : 4 ¢ - 3 om . L. .. I

char format 2} : 5 d . % . . p N d . . . . L .

Packed Char roo. / & . . . . . N . | . o R . . . *
16-Bit Hex - C Style 0% .3 ; c i ?
16-Bit Hex - Tl Style . . K H + i { »
16-Bit Signed Int . e d H . X roo> + D
16-Bit UnSigned Int 1 E } ] . . 3 K . { -
16-Bit Binary . Ft . K e . . C . . . { .M ; . .
32-Bit Signed Int . . . . . % . Cn . . . .od . .1
32-Bit UnSigned Int I L S .
32-Bit Hex - C Style ¢ .. . . .. 1 R . . . . . . 8 Z . K ;
32-Bit Hex - Tl Style . - . 3 7 f ? b C #
32-Bit Floating Point A . . 5 W ;0\ # g ( K E

4. E|AE A
&

HH| A7t A= HAIZ Al B HIAE 5
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2. Controller Tester C|HH7{ A& 70| =

CodeScroll Controller Tester E}Z] E|AE 431 A| C|HHH{ AR 20| Cliist 710| & A L|C}.

» Lauterbach TRACE32

* PLS Universal Debug Engine

+ ISYSTEM winIDEA Debugger

* |AR Embedded Workbench C-SPY Debugger
+ Texas Instruments Code Composer Studio
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2.1. Lauterbach TRACE32

Controller Tester= TRACE32 C|H{HE AtE5SI0] EIA HAEE & 4 Q&LICH
Controller Tester= TRACE322| cmm A3 ZEE ALE5I0] E}Zl S H0|A HAEE A5t Z20E 7S

C}.
TRACE320| M Z|5t= EFZ] 22 Lauterbach S14|0| | Of|A] &H0IEt 4 Q& LT}

e« cmm AJEIE = MM Q] B}l 22

+ Step1: Controller TesterO|A EtZ! $tA M 517]

- Step2: EtZ! HIAE AlSHG}EY
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2.1.1.cmm AJZE S MM 2| E}Zl 22

Controller Tester= cmm A3 E OIAUZ 522 A5t
omm AAYEES AT WYHE 4 U FR0= B2l Y
2 M4 4 Y B0l AFBATE 27 2

=]
M cmm A3 E 243 Y9 S AYStE EHA2 Of2fiet 2Lt

mpc5554, mpc5553, mpc5534, mpc556x, mpecs551x, mpc560xe, spc560bxx, spc560pxx,
spc560sxx, mpc560xb, mpc560xp, mpc560xs, spc563mb54, mpc5632m, spc563m60,
mpc5633m, spc563m64, mpc5634m, mpc564xs, mpc5668, mpc5674, mpc5644a, spc564a80,
mpc5642a, spc564a70, mpch567xk, spcs56hk, mpc5643l, spc56el60, spc56el70, mpc5644b,

PowerPC mpc5644c, spc564b64, spcb6ect4, mpc5645b, spc564b70, mpc5645c, spc56ec70, mpc5646Db,
spcb564b74, mpc5646¢, spcb6ec74, mpc5676r, spc56ap, mpc5746m, mpc5744k, spc574k74,
mpc5777m, spc57hm90, mpc574xp, mpc574xg, mpc574xr, mpc577xk, mpc5777¢, spc570s,
mpc5726l, spc572l, spcd74s, spcd8ne, spcb8eg, spcd8nn, spc582b, spcb8ec, spcb8nh,
spc584b, s32r274, s32r264, s32r372

mkw01, mkw20, mkv30, mkv40, mkv10, mkv50, mkm30, mklO, mkl10, mkl20, mkI30, mkl40,
mkI80, mk0, mk10, mk20, mk30, mk40, mk50, mk60, mk70, mk80, mac57d54h, mac71x1,
mac71x2, mac71x4, mac71x5, mac71x6, mac72x1, Ipc51u68, Ipc54xx, Ipc8xx, Ipc11xx,
Ipc12xx, Ipc13xx, Ipc17xx, Ipc18xx, Ipc21xx, Ipc22xx, Ipc23xx, [pc24xx, Ipc28xx, Ipc29xx,
Ipcd0xx, Ipcd3xx, imxrt1064, xmc1100, xmc1200, xmc1300, xmc1400, xmc4100, xmc4200,
xmc4300, xmc4400, xmc4500, xmc4700, xmc4800, tle98, s3fm02g, s32k, sbela, sbelc, s6j3

ARM

tc2dx, tc21x, tc22x, tc23x, tc26x, tc27x, tc29x, tc35x, tc37x, tc38x, tc39x, tc116x, tx1167,
tricore tx1197, tc1724, tc1728, tc1736, tc1762, tc1764, tc1766, tc1767, tc1782, tc1784, tc1791, tc1792,
tc1793, tc1796, tc1797, tc1798
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2.1.2. Step1: Controller Tester0j|A E}2] &t
2 4ds17]

Controller Tester2| Ef2! 22 A H|0| 2|0 M ClE{HS MEABHL|Ct TRHE0| MENEl S3|210] Tt 2|5}
= LA 55T TA|ELCH

ClHHAHE TRACE32= A gLICt.

b Freescale ¢ CodeWarrior-MPCSSxx » 2.6 » others ¢ trace32

MEISH YE0| Iet 2 S=5S0| EA|ELCH TRACE32 BHAHE AMEst= 890 2dslolsts &=2 oted

TRACE32 Alsimiel A2 QIL|C}. EFZIDICE AlSHIiQlo| Ct27| 20,

|
. o =]
trace32_exe_file_path AF25HE E1710] AIBHIICIO0| TH=32| BHOIIOF BHL|C}. TA 5+20]L|C}.

2T o—dg

EfAl 2tEF0| 2E517| 25t 8io|H 2| oY B2 Y LT} AESH= IDE &
target_binary_path = 2E AT EO|AM EFZ HO|H2| IYUO0| dH &= =S &Qlstn
YL ct B d=YLC
chi AE3StE EFZIQ| ) 0|§S YHAYLILE cmm A EHES s 4de
> 0 AFZ%[7] W20 ZEtet 2 0|52 YHsHOF JL Tt
AH82} 2ol cmm ATZE Tl A2 YLICE cmm ATYE AL A
S 2|QUBHR| oH= EF2IQI A0S CH{ O} EF2I AL BHAS A HEHS
= A H = [ulinl LS AL oOoT — o2 =2 o [
user_defined_cmm_script_file_path AT2lES 25 7LL AFRSIT 9/ omm AJ2IE Tjol HZ = o
2430} SLict
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2.1.3. Step2: E}Zl H|AE AlGH5}7|
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EIZ E|AES A3li5ty| 20| M3l £0I TRACE32 ZZ2 128 Z25H0f §hLct
EHIAE WIH|AHO|E] Kol ZRAE HEAE b0 A [EL2] HIAE A3st7(]12 M
EZ2 225104, E2 HIAEZ Al &~ JASLICE
« [EFZ HIAE M3l5H7|]
Tg |2 E LH| 7 0|Ef F s ¥ =08
4&§mﬂ
B MEZ BHS7|(N) b
X ARHID) Delete
O|Z HFR7|(M]... F2
fu FHER27|(1)..
7 LHELZ|(0)..
MEZ 30X 2|(R F5
ZZME ©H7|(5)
ED AP £ v
» ErZIHAE 4
14 EFZIHAE 271 7127 b
. (A3t

FHHZE

nfm
oo
m
Im

€5171Lt B AE Ho| [A3] b

ol EfZI E|AEZ A3 mf TRACE32 T2 10| AIHEIL|CH HAKHOR HAET} 2R &0

TRACE32 ZT27240| 2}=02 Z2 &L},
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2.1.4. C|HHE
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E3f E}2 HIAE ClH2517)

o

® N o

11.
12.
13.

ElZloz M & QU HAE' oM HAE #H0|A 222 5O/ ¥E &0 22
AFEA D2HES 2| YE 52 Controller Tester Z2HEOf| A ‘BRI &t Y0 55 2= 238

E 43

Ue HEsheal ol

Controller TesterO| M ZZHE S 0| Y E AL 22

Trace32 A3 & cmm A3 FHE M (start.cmm)=2 €0 ‘debug’E A3l (Controller_Tester ZZHE

4 2/.csdata/target/start.cmm)

‘step’ HES 22I5H target.cmm AT E X 2I0IOZ 0|F
target.cmm It 2| Go.HII0|| breakpoint |4

Trace322| Var > Show Function 22!

HAE CfA 4 M & HE 22

Sh4~ A|2HE0]|| breakpoint 2|4
‘step’ HES S 2510 C|HH A ZOIETJ} 10H0||A 2| A Q|2 0|55t= A4S &0l
Var > Show Local.... 22I5}0 2| QB£0| 740| Bat= #S &0l It

CltZ ZAETZ| 2
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2.2. PLS Universal Debug Engine (UDE)

Controller Tester= UDE C|HHHE AtE2ol0 EtA HAEZS & 4 JUSLICL
Controller Tester= UDEO|A| X|5H= C|HZA ATJZIEEZE AR50 E
A=

UDEO| HZ5t AtES 4= QU

-

E}7) 222 PLS S10[2] 0f M &OIE 4 Y LICH

rr

Controller Tester0jA{= UDE 3L 0|A YES ALESHO] EFA HIAES SALICEH 27| W20] AME A}
= EIZ HI2E 3l 0| HA IAAHO0[AS 44Ok LT

T o —

» Step1: UDE IDEOA] 2|3 AT O|A AMMSHY

+ Step2: Controller TesterOAM EIZ! &tA M A 51|

« Step3: EIA HAE AlSHSEY
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2.2.1. Step1: UDE IDEO||A| Q| 3 AH|O|A A5}
a

UDE+= UDE desktop IDEO||A{ UDE ¥ 3AHO|AE Mgt o+~ QSLICE.

1. ALgsts BHO| 2= 28 TS HEiste] T AH0|AS g -Lt

Select Target Configuration

Last Used Browse |

Folder to browse :

{UDE 2X| 4 ZWTargetsW j

Additional Filter: j

Files in folder : [ Show descriptions

Bl MXP XPC560P Mini Module with MPC5604F (Jtag)

Default New Copy Edit Remove

2. ACHO|0i A [File] > [Load Program] HHES 22

=

— =2
E FCRPE YoE Hio|2] THYS MetELCt,

][l

t2 Bro|H2| Y-S 2 4 ASLICE ojn &
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File Edit Debug Show Views Tools Config W

[0 New Workspace CTRL+N
& Open Workspace... CTRL+O
kS Save Workspace CTRL+S
k2 Save Workspace As..

Save Workspace as Template...
H Save View Content As.. CTRL+ALT+S
= Close Workspace ALT+F4

Ell__.:rad Program
. Connect Target System..

< Disconnect Target System..

Print Setup
Print

CTRL+P

Recent Files

Recent Workspaces

Exit

3. O|= OtL{of| w2} [program] HES +2H E

o o 11—

Controller Tester User Guides - 3.3

t2d 2E0 Tat BiojH 2| THHO| Bt 2 Eg LT 2 &7t
YYHo= LY YIAH 0|~ Yo f2FUCH [Exit|E 22510 22 WA LS LI

. UDE - FLASH/OTP Memory Programming Tool - Controller0.Core

—FLASH/OTP - Memany Dewvice

IPFIASH: 512 kByte OnChip FLASH
Index | Start End | Size |

i D00000000 (00007 FFF 32K
Dx00000000 Dx00000007
Ox00000020 Ox000002FF
Ox00001000 Ox00001147
Dx00002000 Dx00007FFF

1 Dx00008000 0x0000BFFF 16k,
Ox00008000 0x0000BEFFF

2 (00002000 [x0000FFFF 16K,
Dx0000c000 Dx0000FFFF

3 M00070000 (0001 7FFF 32K
Ox00070000 0x00013F78
Dx00074000 Dx000170D7

4 10N 200N MNNN1FFEFF sk

Remowe All

Remowe Sel.

LI [v Enable

Eraze ...
Frogram
Wearify
Hvs' Protect ...
SW Protect...
TestEmpty ..
Info ...

Setup ...

Exit

About

PRl

Help

[Erl .

General ...

Fragrarm All

d

Verify Al

AfM|eh Atet

2 UDEOIA H25te DS 22 5HIAIR.
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2.2.2. Step2: Controller Tester0j|A E}2] &t
2 4ds17]

Controller Tester?| EfZl 2t8 2 H[O|2[0| M E[HAHE HEAFLICH Z2HEO| HEIE S| Q10)| Tt 2[&S)
= HHA S=T EAIEUCL
C|#7E UDE 2 4y &LC.

b Freescale ¢ CodeWarrior-MPCS5xx # 2.6 » others ¢ ude

=0| EA|ZLIC. UDE CIHAE AtEste 320 €daliotet= &

ElZl St A Cs |5t gio| L 2| o
target_binary_path _ ~ 280 E=517] /2t 4012

H2QU|C} AFRSHE IDE Ei= UE ATRIEO
M EfZL HIO|UH 2| THE O] dd == OEE ghelotal YHEYLC) B S5y L
ude_project_file UDE IDEO||A] M=l I IATO|A T2 E T (.wsx) A= L|Ct T4 SE=QL|CH

Controller TesterO| M AtE5ts 7|2 AFEE

Elzl &4 M3

+ visual basic script L|C}.
8 440| LT [OK] = [Finish]tHE%

SlgHCh EIL HAES
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2.2.3. Step3: E}Z] HIAE

Controller Tester User Guides - 3.3

 [EtA HIAE Zl5H]]
TR B2 1| 0|
4 [ test!

[

ME ZH=S7|(N)

K AAD
0= H17|(M)...
7t 27|(..

LEZLEZ1(Q)...

Delete

F2
)
3

ME A% 7|(F)
=Z=8E 2703

F5

e

& EMZIEAE 4
14 EfZHAE 27 FHHS7)

FHHZE

nfm
o
m
Im

— &

Cf

QI5H

o

£ C++, .NET, Perl 52| 20|12
ZI

O{ S0l Cisl{ M= UDE O w0l =

4 LA3EHE
= O
- EO;-I

Al

i ) I'I'I
Jk"' FIF O

x4 S

MEHSIALE E|AE Fo| [Al3H] H

L|C}. AQRIER 2HASH

2
=
Automation Basics A&
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2.2.4. C|H{HE
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Sofl EtAl E|AE Tt g st7]

N

© ® N oMW

Controller TesterOj|Aq| Z2HE %
Pls Ude Al S T2 A E MEH(.ws
2HO| A LEE outputTtL S ﬁE_|
|AE CHA ol-/\jl. ol AA]:[l.% dg_Hl S 5t40| Ot 2 EOJE

FSHES S~20 entry point0i|A{
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2.3. iSYSTEM winIDEA Debugger

Controller Tester= winIDEA C|HH U AJZIES E5l| A} 5O 2 E}J] S HO A HAEE Adi5I0 ZIE J1HA
=758 A3
WinIDEA7} 2| l5t= EtZ] 222 iSYSTEM E1 0[] Of| A &H015t 4 Q&L

m

.

[
o
Im
10
nx
ogt

= winIDEA 22| A| &7} 22|%[= python SDKE 222 LT 2 22[E[0f U]
DK 22| HO|2] Of|M CI22EYS 4 ASUCH E5, AFESH= winlDEA B0 3T

2|45t Q=2 EQISHOF BHLICE Controller TesterOijA 7| 222 A|&5t= [/ A3 E= python

C

un oy O
P[>
)

_<
%)
_|
M
<
%)

<

w
w
£
2
o
N
[N
|0
Hu
IR
T

—_

O] 2XO0j|lA= winlDEAOA E2HEZ MM GH= Z{2E{ Controller TesterO| A E}2] HIAEZ A84517|7}2| Q]
WES Ol A2t S AHE LT
Ol A|Of| A= iISYSTEM BlueBox iC5000 Unit C|H{ {2t NXP2| MPC56xx EtZlS AF2EfL|CE.

* iISYSTEM winlDEA £ ALE3517| 2I6H At ZH|
« Step1: winlIDEA 2|3 ATO|A MM Ol M

» Step2: Controller Tester0jA Et7l StA M

o Step3: E}Z] E|AE AlSGH
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2.3.1. iISYSTEM winIDEA £ A}23517| 98t AFA
=Y

Controller TesterOf| M winlDEAS AF2310] EfZ] EIAEE 512{H winlDEAR} HESHH ALE 7t Tl A7t
ZegL

A= B HIAE 45 20| winlDEA {3AAH|O|AE AMAMGID AR S C|HHE Controller Tester7} A |
=l PCO} @1 Z3HOF EHLICH
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2.3.2. Step1: winlDEA $|3AT|0|A MM A M

S
(@)
1. winIDEA Mgl = AMCHO|F0| A [File] > [Workspace] > [New Workspace...]& MEHGSIO] Al 22 HIA
HO|AE M-gefL|Ct. M/ dst JIAATHO|AZ Controller Tester Et2! HIAEO| AFESH| QoAM= 27t &
4 H430o| Tagct
| w| winIDEA
File Tools Window Help
d  New.. Ctrl+N
& Open. Ctrl+0O
H Save "trl +
@ Save All
0 Page Setu
@ r Ctrl+F
Select Workspace...
Workspace 51 New Workspace...
Open Workspace...
Source Control 4 = ) pen Jorkspa
2. Z HAYZ AT 0|70 M [Hardware] > [Hardware...] & 225t =, [Hardware Type] 0| HZE

BlueBox2| 22 MeygtL|ct.
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pod

Hardware Configuration

Hardware Type  Communication

Hardware
iC5000, MAGZ2k e

System Configuration

3. Ct&22 [Communication] ROI|AM S41 &HAl HH5t0 [Test] HES &2 7|7| HES &elgHch 84
HEAIO| 2 |7 ZiH| 12 Yo Ciet AH 2 iSYSTEM BlueBox O 5 S 2 RFHIAIL.
Hardware Configuration x
Hardware Type Communication
Part
(@) UsE BlueBeox Unit (serial number) «
() TCRIP IP addr Port 5313
Use global discovery on UDP port 58371
iBRIDIGE Bridge Configure,..
Device
n USE and TCP connections #£12345 notation can be used to
nnect to device with serial number 12345
SEB: For optimum streaming performance
- Always use quality cables
- Avoid hubs
- Perform comm. test from different host PC ports
2 22|3fM EA5A7! &, [Hardware] >
2l 222 MetgLCt.

4. At 04+ 2 [Hardware] > [Use Software Breakpoints]
1 9| [CPU] ¥=0f| M AEE Ef

o
[Emulation options

Page 23 of 74



Suresofttech Controller Tester User Guides - 3.3

E] demo_workspace - winlDEA
File View Hardware Debug Test Tools Window Help

n Project Hardware... E —
= x |Filte License... o
=] Initialize =
E Emulation Options..
2 CPU Options. >
e Use Software Breakpoints @
= Use Hot Attach __E
] E
FLASH 4 5=
= o
= ELASH Setup.. _
— )
Analyzer Setup ;
Tools...
= Options...
Emulation Options >
Hardware CFU Initialization Initialization After Download
Famil POD/ICARD/TAG cru|
MPC56048
| e | MPC5604C
P
| SetDefaut | m
MPC56058
MPC5605BK
MPC56068
MPC5606BK
MPC56065
MPC56078 v
CPU wariant
(default) e

e EtZl ¥2 MO SHe MR S40| CHE 4 &L

5. 7|7 43S B LHH HAES HO|H2| B2E SSalj0F ZLCt. HA HAE O A4 FES HE
510 Hio|H 2| & A &L Ct. O3 2 winlDEAS| AT 0|5 [Debug] > [Files for Download...]0i| A
[New...]& MEASI D 247

HHfO|H 2| H2E IS UL

rol
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Download X

Download Files Options Target Download SMP  Endian VLE  Overlays

Path Type Offset

MPC5604P_Example¥tbintinternal_FL... ELF r

MNew... Remove Properties...

Memory area | default o

[ ]include project output file

Default file for debugging linternal FLASH.elf w

6. HIAMO|A HHO| ELIL, YA O[AF A ZSH0] winlDEA {3 AT O[A IHU(.xjrf)
UIAAHO|A T2 Controller TesterO|A winIDEAZ 0|25t EFZ] HIAE A& Al AIR

AI AL CY,

ocood

o

IL|C}.

il
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File View Hardware Debug Test Tools Window Help

O New.. Ctrl+N -

& Open. Ctrl+0O ~
Close Ctrl+F4 =

A cave Ctrl+5
a2dVEe AS '

@ Save All o
A o Ter = 5z

@ Page Setu [;::

& P Ctrl +F o
Select Workspace... T
Workspace 3 New Workspace...

Open Workspace...
Source Control = pen o obe

@  FEind In Files.. Save Workspace Template...

Exit Alt+E4 Close Workspace

O[A| Et HIAEZS 5t7| 2leh winIDEA {3 AT 0| A H-0] ERtE LT
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2.3.3. Step2: Controller Tester0j|A| E}Z! 2}
A 2]
= O

Controller TesterQ| EZ]l HIAE T2 A E AHM OHA E= T2HE T ZIHE|Q| EFl &4
MEBHLICH Z2ME 444 Al el SX0l0) T2t Mei Jhs3 Clbi7| S20| YA,
C|HHE BlueBox 2 H&gL(Ct.

b Freescale » CodeWarrior-MPCSSxx » 2.6 ¢ others »  bluebox

olM EIHAES

M

HEfeE 20| Ifef 2 &=5S50] EA[E UL BlueBoxE AtEst= 870 245H0F of= =2 Ofeff ot &

12 QI2AGHOf 5t= &2 Controller TesterOjA{ 2 Alo2 HA|E L|CH,

winidea_binary_path winIDEA A!3H T}l (winlIDEA.exe) 2= QI L|Ct. T4 2 QILICY.
winidea_workspace_file_path winIDEAO|M AM/AdSH I AT O|A T (.xjrf) 22 L C Z4 SHEQIL|CE.
Controller Tester0| A AI5H= 7|2 A3
8%, python2 2 2H/d5l{0F d 2ot Ef 2l B 2]
= d20|= iSYSTEM 2H0|2] £ 2t115t0{ 27t SDK Mz|E 2!
ERZl &tF 4E0[ ELIE [OK] E£= [Finish]H &

Page 27 of 74


https://www.isystem.com/downloads/isystem-connect-sdk.html

Suresofttech
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HIAS UlB| A 0lE] ROl ZRHE ALIAE Ol50M [E}2 HAE Mas17||S MESEH L EAS Hol [Ma]
S2 3250, B2l HIAES MaY 4 UsLCH

* [EI2 HIAE AT

g HIAE HH| 70| HE& ¥ = 0
4 [ test!
o MEBSIIN) b
K AHD) Delete
0|2 Ht37|(M)... F2
Ry 7HEHR7|()..
Ea  LELZI(0)...
MZ 1% 7|(F) F5
Z2ME CH)(S)
3@ e b
& EfZHAE 4
% Ef2 HAE 2727 C

FHEZE

njm
ot
[ra
|m

ole WinIDEAY} A3l 201 MEHO M Et2l E|AES £3liSH 4= gi&LICE Controller Tester0f|A| Et
A HAES LS| Mof| BFEA| winIDEAS ZZ6H0F &L T
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2.3.5. C|H{7{ = Sl Bt E|AE C|H 51

1. B2 28 = ‘RH HAE oM HAE #H0|A 228 = T YL &

£ 2 2 E =2 Controller Tester T2 M EO|M ‘EFZ] &t Yo SScHEHE A3

ro
ujy
I

N
>
o
X
|H
Hu
Jé
[m

T

[Debug] > [Download] MENGIC] BIO|LH2| IHY EFZI0| CIREE

AT Run HES S2H CHZ 22

[project workspace #] > [Functions] &= H& 22I5t¢ dild e+ 2= 0|5 =, ¥ot= 20| C{HL
ZolE 43

9. F52f C|t{Z 2t

o N o o0~ W
=3
=2
O
m
>
>
0%t
fon
ne
N
rok
|H
Hu
4
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2.4. IAR Embedded Workbench C-SPY
Debugger

Controller Tester= IAR Embedded Workbench C-SPY C|HZ 7|52 Ealf AAs2=2 EtAl & H0 M EHAEE
Aeistd 20E MM RE 73 AlSE UL
C-SPYO|M 2| d3t= EHA =52 IAR 20| 2] 0| M &l 4~ S LT

Controller Tester0j| A IAR Embedded Workbench C-SPYZ2 E}Zl HIAEZS 5™ C-SPY C|HZ 7|=& At
2% + U= 4 d 2287 WL O AFE A= EH HIAE 43 M0f| IAR Embedded Workbench &= 2
EE MMSID AtES C|H Y TZE E Controller Tester?t Az|&E PC2} ¢ ASHOF L C}.

IARO|[A A|S5the LM E 25 S 52 AR 21 0[2] oM &let &~ AG LTt

» Step1: IAR Embedded Workbench T Z A E Al

o Step2: IAR ZZ=HE MA
« Step3: Controller TesterOj|A EFZ! 2t A A A
+ Step4: ElZl HAE AlSH
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2.4.1. Step1: IAR Embedded Workbench &=
HE AN

1. [File] > [New Workspacel2 22/510{ Al JIAAT0|AS AN

M35t = [Project] > [Create New Project...]
£ 225t0) T2 E T} (ewp)S MABILICL T2 E AL AA5tT LIY IAR Embedded
Workbench?@| [workspace F]0f| Z 22 )

|E O|50| EAIFUHC
Warkspace x

v O
Debug e
Files B

® sample_project-De... +

2AUEE o=212 5

EZ 2223 510f [Add] > [Add

2 [workspace R]0|A A& F2=2 FIt
A TS SHolE 4 YL

Waorkspace w 0 X

Debug o

Files O

= @Wsample_project-De... «
tnain.c
B Output
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R
DRHES M

o t
2l510] [Options...]& M

ﬂJl

B LICE

1. D2, [General Options]Oi|A{ [Processor variant]2 AZ&tL|C}. O|E S0,
olase
o

9| B DeviceE MEHSt & 2Z9| B}l Z=0||A 5

Options for node “sample_project”

Categony:
Static Analysis
Runtime Chedking
CjC++ Compiler Library Options 2 MISRA-C-2004 MISRA:
Assembler Target Output Library Configuration Library
Qutput Converter = o
Custom Build Processor variant
Build Actions
Linker (O Core ARMTTOMI ~
Debugger
Smulator |®0eice | |None l
CADT
i, Ocmsis-pack  MNone
GDB Server
T4et Endian mode Floating point settings
I-Link/)-Trace =
T1 Stellaris @ Little FPU Mone
Mu-Link O Big
PE micro D registers B ~
BE32 £
ST-LINK I—I
Third-Party Driver BES
TIMSPFET
TrustZone
TS DSP Extension 2
hode [Secure
Advanced SIMD (NEON)
oK Cancel

2. =2 Z [Debugger] 7tH| 12| 2 0| =
MEHSE B2 T2 9 PCE HZASHY!
M2 W8S dE L

o= =2o0od

B C-SPY CiH{Z 7|5 AL8 S 95t ZRME A
.I

Maxim

Mediatek
Microchip
Micronas
Microsemi
Milandr
MindMotion
MitsubishiElectric
NetSilicon
NordicSemi
Muvoton

MNXP
ONSemiconductor
Qorvo

Redpine

Renesas

Samsung
SiliconLaboratories

504, [Driver] 20| AL

»
*

»

»

¥

»

>

*

*

¥

¥ Other
> SPEAr

> STM32F0
¥ STM32F1
¥ STM32F2
» STM32F3
¥

»

¥

»

»

¥

¥

»

»

»

»

¥

>

>

>

STM32F7
STM32G0
STM32G4
STM32GB
STM32H7
STM32L0
STM3201
STM32L4
STM32L4+
STM32L5
STM32MP1

St 8fAl0)| w2t [Debugger] 9rE|ﬂa| 5t

STM32F401
STM32F405
STM32F407
STM32F410
STM32F411
STM32F412
STM32F413
STM32F415
STM32F417
STM32F423
STM32F427

STM32F437
STM32F439
STM32F446
STM32F469
STM32F479

B T ]

v v v v

5T STM32F429AG
ST STM32F429A1
ST STM32F429BE
ST STM32F429BG
ST STM32F4298I
ST STM32F4291E

ST STM32F42911

ST STM32F429NE
ST STM32F429NG
ST STM32F429NI
ST STM32F429VE
5T STM32F429VG
ST STM32F429VI

ST STM32F4292E
ST STM32F429ZG
ST STM32F429Z]
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Options for node "sample_project” *

Categony: Factary Settings

General Options

Static Analysis
Runtime Checking
C/C++ Compiler Setup  Download Images Extra Options Multicore  Plugins
Assembler
Output Converter "
Custom Build Driver Run to
Linker

Setup macros

Debugger

[ 1Use macre file(s)
CADI

CMSIS DAP
GDE Server
I-et
Jink/1-Trace
TI Stellaris
Mu-Link

PE micro O Override default
ST-LIMNK
Third-Party Driver
TI MSPFET

TI XDS

Device description file

3. ljetS dESt 2, [Debugger] 7tE| 12| StEHO] [Ijet] =S UESIO] MF &S 2Z L 4 238
= ROMAIL.

Yol CHet 2F2 AFESIAL 5t IAR LIHA B 72 S 2

o
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Options for node "c_proj"

Cateqgory:

s

General Options
Static Analysis
Runtime Checking
CfC++ Compiler
Aszembler
Output Converter
Custom Build
Build Actions
Linker
Debuagger
Simulator
CADI
CMSIS DAP
GDE Server
1-Link/J-Trace
TI Stellaris
Mu-Link
PE micro
STINK
ThirdParty Driver
TI MSPFET
TI XD5

ISE‘tUF" Interface  Trace Breakpuintsl

Factory Settings

Reset
‘Cunnect during reset {default) e
Dwration: 300 | s Delay after: 200 | ms
Target power Ernulator
Erom the probe [ Always prompt for probe
P selection
Leave on after debuggin
® 99'ng Serial no

() Switch off after debugging

[]Log communicaticn

$PROJ_DIR$Wcspycomm.log

Cancel

O[A| EfZl HIAES 5t7] fIEH IAR 224

E 44 4 240 ExtgHt
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2.4.3. Step3: Controller Tester0j|A{ E}Zl &t
A 2]
= O

Controller Tester@| E}Z! H|AE T2HE MM OIHAI £ = T 2HE T Z2HE|Q| EIZl & d MHNM CIHAHS
MENBILICH Z2RE Ay Al MEIE SXQI0) T2t Me Ths et OB S=0| Dk,

IAR E|Q1S AESI0] Z2HE 4'd A, IAR C-SPY LI 7|52 AE3SHY| fIgiM= EIH A S ide2 S5
OfF gt

b IAR » ARM-Compiler b 5x b others b ide

St YEOf| et 2 S=5S0] HAIFUCE C-SPYE AEst= 820 24s5l0f ot &2 Ofefl Bot Z5

|A_ Y =20 o©
L|C}.
42 UASHOF ot =2 Controller TesterOAl & MO 2 HA|E L|CH.

IAR Embedded Workbench C-SPY C|H{{E AtE A| 25t
. debug.general.xcl It ZZQL|Ct IAR T2 AHE MM A| ZZHE T}
cspy_debug_general_xcl_flle_Path o1 ewp)o| 2121l 21219 [setting] ZCIofl A4S L LICH B4 32
ol |__| [:_|>_
=]

IAR Embedded Workbench C-SPY C|H{HE ALE A| 226t
. . debug.driver.xcl I}Y ZZQIL|CH IAR Z2HE MM A| T2HE T}
cspy_debug_driver xclflle_path  ( ewp)ol 242l 9112 [setting] BEIO| 25 SHELICH B4 29
Lick.

—

0
ot
M

HI7t 2%tE

Bt &d 2¥0] EL4E [OK] £ [Finish]HES S YL EIA HAES |C}.
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EIAE UEIAIOE] Bo| TRHE HEAE OR0A [EF BIAE AH3E7[12 MEBIH L EIAE Hol (4] 8
£2 22510, B2 HIAES M3 4 ASLICH

* [EI2 HIAE AT
T EIZE HH| A O|E

4 [ test!
f ME BHSZ|(N) r

M

i
q
I

1

K AH(D) Delete
0IZ HFT7|(M)... F2
By FHEL7|Q).
i WEWZ|(0)..
ME X 2| F5

ZERE Z2Y16)

Zz @ er >

& EfZHAE 4

% EIZEHZEE171R27| b

FHEZE

njm
ot
[ra
|m

Page 36 of 74



Suresofttech Controller Tester User Guides - 3.3

2.4.5. C|H{7{ & Soll Bt E|AE C|H 51

1. B2 28 = 'RA HAE ROM HAE #0|A 253 = T8 Y& 2I' Z=Output IR0 E
o1 A= =2

2. AMEAZZAHES 2H YE =2 Controller Tester ZZ2AE Q| A ‘Ef2] &tF A0 SScH e A3
E 43

3. WE 435He Sl

4. IAR Workbench &3 & 1ESt T2 M E E5Hot= AL 0[A MEH (ewwItY)

5. workspace HOIA| EIAE CHA 81471 Qi AATIY M 3, 210 Y22 22510 C|HY EOIE 2

6. workspace FO|A Z2HEES 232 Options...& E0f Debugger &=0{|A& Run to /4 2|3 =el &

‘main’22 2|0 U2 =0l
Attko| Download and Debug HHE S =2 ™ maing g ASH
F5 S2{M C|HZ ZEQIENIR| 2IEH5H0] CjH Y

N
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2.5. Texas Instruments Code Composer
Studio (CCSv4 and greater)

Controller Tester= CCS C|H{HE AtE5I0 EIZl HAEE &
Controller Tester= CCS7t X|¥st= C|HA AT E (4. xHA
1 ZE JHSUC

CCSof| HZ5t0] ALEE 4~ U= LI B F52 CCS Ui S &QsHAl2.

A

=
=

OII

0| M0 A= CCSO|M ZZ2HE S MM5H= ZIL2E] Controller TesterOf| A E}Z! E|AEZE Aali5H7| 72| Q] 2t
= O|A|2f et Lt
0| A|0j| = Spectrum Digital®| XDS560v22} Texas Instruments2| TMS320S A2 &L CY.

+ Step1: CCSOM TZHE AHMTFIY|
+ Step2: Controller TesterOAl E}Z! 3tA M A 517|

» Step3: EZl HIAE AlSHSLY
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2.5.1. Step1: CCSOj|A| T2 HE AMMG}I|

1. CCSE Hdistil Ml Z2HES YdeiLith 2[&¢l Hlw0lA [File]-[New

12 Mt Slof 2sts Befl
Z2MES MEYBILICE 07| A< [CCS project]S 225t0] TRMES MAFILICL A3t EHLRt T
7| FEE QD F [verify]S BB, FYHOR AAE| UL SHOIT 4 ALIC

New CCS Project @
Create a new CCS5 Project.

Target: <select or type filter text= ~ (#TMS320F28335 w

Verify...

2. CIH{HetEZ HES Elet
°

< LI 2= LHTLICE OfA[0A= C2000 Ti AL S AHESLICEH
[Finish]2 22l

S CCS B2HET} AL 0| A0 H-dE LT

ocood
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[ C28XX [C2000]

Project name: test

Use default location

Location:  CWeocstudio_wsWiest Browse...

Compiler version: | Tl v18.12.3.LTS More...

v Tool-chain

~ Project templates and examples

type filter text Creates an empty project initialized
for the selected device. The project
will contain an empty 'main.c’
source-file.

~ [5 Empty Projects ”
& Empty Project
(& Empty Project (with main.c)
& Empty Assembly-only Projeci
& Empty PowerSuite Project
[& Empty RTSC Project

£ >

Open Resource Explorer to browse a wide selection of example projects..

Open Import Wizard to find local example projects for selected device...

@ < Back Next > Cancel

CCS& Texas InstrumentsOj A 7| 222 A& ot= ClHA 2|0 22| CIHHE o XL .

TI XDS USB (CCStudio default)
BlackHawk JTAG emulator
Spectrum digital

MSP430 USB

MSP432 USB

Tiva/Stellaris ICDI

2

203 ClB{2 2 AN HEE Sl

]
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2.5.2. Step2: Controller Tester0j|A E}Z! 2+
2 4ds17]
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1. CodeScroll Controller Tester Z2 A E S A/ eHL|C}.
CodeScroll Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64)
LR EBHEE S¥Ea) =ZEXREPR EHEIEZEM 2w ESZH)
ME HE=7(N) B AA W CiCes EEEE
S
=7)(Q) Crl=W ﬁ SIH O] £ (CodeWarrior, Green Hills, NEC) C/C++ ZEEE
H H AEE il & E
25 27| Ctlsshiftw | ¥ HIFE 2RO C/C ZERE
E 7= CodeScroll EEXE HEES ¢/C++ TEHE ¥4
HEHS) Cirl+S | = e _
CPI IZSE C/C++ ZEHE ¥
D= HEE Ctrl+Shift+5 | =
25 HEE trl+Shift+5 B 2T MESsE .. DTEEE BN
0|Z BFRZ|(M]... F2 |[@] RIv 2CC/C++ ZEHE
ME JIXZ|(F F5 |8 RIv 2C MO C/C++ ZEFE
YIAHO|A BRI (W)... [ 22 0 C/C++ E}Z HIAE E2RE
b THRR7)().. g* oI C| E(CodeWarrior, Green Hills, NEC) C/C++ EfZl H|IAE ZT2EHE
o WEWO). B 4L HEEZSE C/C++ B BIAE TS HE MM
S8R Attetnter | [ 7ISHO)- Cri=N
EEX
2. 4435t Code Composer Studio toolchains MEHSHL|C}.
i Bz=== o x i
| MEzmE ‘
MEEEMEES HHETLICH
ZEHE 02: | CCStesf |
LR |C:Wct_work5pace | |
EHOl M= |‘
l 7= EHDOE 23
CCS teelchain
O GCCBA
| VS2017
| V52019
O GCC 4.7 (32bit) NS WHE SO
[ GCC 5.3 (32bit) TEOZ MME|SL|CH
O Microsoft Visual Studio 2010 (32... AHE2E MMUEASLICH
O Microsoft Visual Studio 20010 (32 AFE2 =R MAETsL|OH
I
EHE=F
< 0|E®B) ChE(N) = 2H=(E Hx

Page 41 of 74



Suresofttech Controller Tester User Guides - 3.3

24 HYS HIHUAL.

Z &9 CEHC: |D:ch5_work5pacew12.?'test | HOLEZ|(B)...

CIZEE| o

v 12 Ttest TE EA
Jaunches
Ssettings
Debug
targetConfigs

ol |
=

[t

main.c

ZOEET|(B)...

B AA OU SRS v EE R FAE PR HAR)

< O|E[B) CHS(N) = 2= H=

=1 P M A @2 ¥ B === i
MEEuE 4 AR ST yEuY BE BREE = .
LCEELFTLT] T MERE SMODC (DAY f #RARLE AN ZEINE USR8 iRsIeAs TEe
B HAE HENE % : & mainc 13 =] # e - =0

~ FE AT

1/0/001 100.0%

- int waim(vedd)
{
FeEE

o 100.0%

return 0;

g Datault Moduk
v L maine
« man

o et
W tsccs
W ettt

oy 0

- - > o= me.- - 5os  .c.iiia]

5. CodeScroll Controller Tester 2| siE TZ2HE 222l & [EM] > [EIZ HAE] > [EtA &E]1 M 44
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2 ofioF &L Ct

=2 [=]

MESH H 20 w2t 4y &=50| HA|E LT Code Composer Studio C|H{HE AFESIY] EHZ HIAE
£ A oM e [EE] A [HA] oM WMo 2 H L= 220 22 YA OF BLCt.

CIH7HE AFE35}H7| QI3 Code Composer Studio, CodeScroll Controller Tester 0| A{ A4S §hL|C}.
Controller Tester2| Ef2l 2t8 2 HO[X|0f|M CIHAHS HEHSIL|CL T2 HEOf HEIE S0 Tt

A|95t= CH A S50 BA|E LT 0| A0 A= Code Composer Studio CI|HHE ALESH| I Z0i| IDE
C|tH 42 MEHEL|CY.

— g

b Tl » C2000 » 62 ¢ TMS320F28x » ide

gl EH
=2e— 4d
Code Composer Studio 2EE 517| IoiM= EFA 2t dZol 2 HoM st JESS st
@S SELICL 2450} SHE 322 Ofel Hot 2On], Ol T4 B2 QLICE
B costest £ O *
TH EAE g (D Ef2 BJAE 4P A B|2E ICF UCBLL +=EO= B BAEE TIPS UL 4T B U+ YRS U0 HES2 B BAES § + UsLTh - - v
;:_E"Q P TI e C2000 b 62 ¢ TMS320F28x b ide EZl 74 2} %o
v Etl a2 P
Z! g\g WLC Ag3IE =
gz 24 OsE 233= 42
e g @
w8 use_stdio_header false
7|t use_std_string_header falee
ide_directory_path C¥tivccs920
workspace D:#ees_workspace
project_name 12.Ttest
toolchain_kind ti
0|8:
EEE] EES
dc e 5t
ide_directory_path Code Composer Studiol| C|Z#E2| AZ ex.C:\ti\ccs930
workspace Code Composer Studio?| ¥ AALO|A CHEZ| BZ
project_name Controller Tester0| M 2Agt Code Composer Studio Z2 X E 0|&
A o
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B ccstest 4 o X
WE HAE oF EFI HIAE 43 A HIAE ACE WESHD WS -
B4 Ga
E b TP C2000 » 6.2 ¢ TMS320F28x b ide EfZ 83 7He
v EtZl HAE =%
B2l B3 -
Has 2a | |08 @
SE | | coxml_path Di#cos_workspacew 1 2. Ttest#targetConfigs#TMS 32072808, coxml
@ script_path
SlEr target_binary_path Dices_workspacest 12 TtestwDebugit 12, Trest out
debug_probe Spectrum Digital XDS560V2 STM USB Emulator
cpu_name C28xx
memory_page Memory Page DATA
char_format 5.
018: |char_format |z (@
=2 | memory G A| character
format IDZLULICH 7|23
252 A0 23,
device®] 2} 17 52 CHE
U0 8+ USLCL
HEF 7 FHe

MY ES
Code Composer Studio EfZl 7+ A QILICE. O] It2l9| 0|E2 Code
Composer StudioOf|A& &5t EtZI2| O| S YLICL Z2HE F=2o} E}JIC| 0| F
ccxml_path

Of 2t=2] &elgrLtt.

Of: {project_path}\targetConfig\{target _name}.ccxml

: M3 AYEI 2 AHEOYS A, RS Y (W Y25t Yot
script_path

|C

-

_,_
~

Code Composer Studio YE A| Mg = Hio|H2| Italo| AZ of:

target_binary_path ) )
{project_path}\Debug\{project_name}.out

s EfZ C|H{ 2| 0|E, Code Composer Studio properties2| Device £+

IT

debu robe
9P (Ol A]2] AFZIOf M= Spectrum Digital XDS560V2 STM USB Emulator)

& EfZl CPUS| 0|&, Code Composer Studio properties2| SIE-& (0| A2

AT O
cpu name
P AFRIO| A= C28xx)

Code Composer Studio?| C|HHH7t 2 71=35t memory page , Code
Composer Studio Memory Browser Af2I 2t11

| I e |

memory_page

O L——
char_format A2t 0l: character?} S HEQ| AFCHO| A S E{ 5EHR|O|| QL2 T, char_format 3}
of 558 Y=stH L

Code Composer Studio2| G|0|E{ ZBH = charactere| =M. MO Z2E 12

« Code Composer Studio properties (Code Composer Studio ZZ A E 222! = [Properties] >
[Debug] > [Device])

Debug

debug_probe CpU_name

Device fSpectrum Digital XDS560V2 STM USE Emulatoriz28:x:
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+ Code Composer Studio Memory Browser

== Disassembly O Memory Browser 2 v evFep i
Data ~] [oxo03ra100
Data:0x3fb100 - 0x003FB100 <Memory Rendering 1> &

Character A
8-Bit Hex - Tl Style index: 0 X . . . 0 i . . K z k
8-Bit Hex - C Style index:1 " k W X 0
8-Bit Signed Int  index: 2 e T T .
8-Bit UnSigned Int index: 3 ..y 0 .02 . = x v . 7 . "

-Bit Bi index : 4 ¢ - 03I om . L. .. . . 0

char format 2} : 5 d . % . . p N d . . . . L .

Packed Char roo. / & . . . . . N . | . e R . . . *
16-Bit Hex - C Style S | c i . ?
16-Bit Hex - Tl Style . . K H + i { »
16-Bit Signed Int . e d H . X roo> + D
16-Bit UnSigned Int 1 E )} ] ; 3 K . {
16-Bit Binary . Ft . K e . . C . . . { .M ; . .
32-Bit Signed Int . . . . . % . Cn . . . .od . o .1
32-Bit UnSigned Int L S .
32-Bit Hex - C Style ¢ .. . . .. 1 R . . . . . . 8 Z . K ;
32-Bit Hex - Tl Style .. .3 T 7 4F b c . #
32-Bit Floating Point vl. . 5 W ;o\ # g ( K E

A8 10| A Code Composer StudioZ} AZHE|0f QOB I of2{7f LHA4EHL|CY,

o=

Btz 2t8 20| ZLIH [OK] £ [Finish|HES S UCH Bt HAES Al FH[7F ERtE UL

[ =
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2.5.3. Step3: E}Z] H|AE AlGH5]H]

EtA HIAES ZAsto[of $M EEStNAt St= Z2HET} 2|2|ot I AN 0| A AHES S=5H{0F LT
IDEOJA] IAHO[AS ALE SO[2tH EHA HIAEIL Y422 +lE|R] Eg LT

O

HAE HB[AOIH R Z2HME AHEIAE 0 70|M [Et2! E|AE HllSHY(]E MEASIAHLL E|AE JO| [Hal] B
EgS 321510], E}Z] HIAEE ASiSH 4 QI& LT}
- [E}2] EIAE AEH5H]
g BIAE LHIA 0| 5% v = o
4 |l test!
P ME OHS7|(N) ,
X 4HD) Delete
0| £ HERZ[(M)... =
fv ZHHR7|(0...
1 HELZI0)..
ME X 7|(F) =
ZE2ME ©H7|(S)
e ,
P EZHAE AW
'3 EFZHAE E717HHE7] <
ek
FHEHZE ssigAs

ots CCS2| |1 AJRIEIO| Tt ZkM|3t A2 = Texas Instruments ZH|0|Z| £ 2t DEHAA|L.
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2.5.4. C|H{74 S S3fi E}2! HIAE C|H{25}7]

N

—

—
—_—

=

© 0 ® NGO A

1 EIAE 2E YR 43
CT_¢3Amo|A\.metadata\.plugins\com.codescroll.ut.embedded\Z Z A E H\TestFixture\cs A==
Ol

notepad2 SiE ZZ 020 = 2 & OIUSO| LHZ0|A #line 2ALE //#line2 2 H A (#line -> //#line)
Code Composer StudioOf|M LHELH7| &l B E e 43

ClHA REZ ASHSHH cs_tfx.c I 2| main 40| break point?} A2|= A
Code Composer Studio Of| M 2= AT ‘File’ > ‘Open File’ 22l

2HO| A2 M HIAE S S testeAfb.c IR &7|(ex. zlibVersion_test0.c I})

‘Open File'2 E|AE CiAF §t40| 0|7} Qe AAIY R2f.c UL H7|(ex. inffast_1.c I}Y)
7HO| U= &40l break pointE 2|d, 8210]| U= HIAE T4 G2 A|2}E0] break point 2|4
781 8RO M S U= THYO|M break point?} Ze|= AS &S 4= UAS(8Y2| 2 et Ho| AIRER
20i| break pointE Z| &)

ClHd =3

O]

—

njo
Jtok

Code Composer StudioOf|A{= &f210| S0{Zt AEfe] TE=0 CHZAS & £ AS L T
E5t Code Composer StudioOf|AM C|H{Z 0| 7tsot 2t F0| 70 UR| F2B CHAS &
- SO

T HAHY
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3. Controller Tester E}Z] HIE 7]0| =

CodeScroll Controller Tester E}Z] ZZHE HHE ALE50] Ef2 HIAE IEE Y6t YRS QHLSHL|CY

+ |AR Embedded Workbench IDE Build

+ Texas Instruments CodeComposer, all versions
» CodeWarrior IDE

» Hightec Development Platform IDE

» Tasking VX IDE

* Renesas CS+ IDE

+ MPLAB X IDE
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3.1. IAR Embedded Workbench IDE

3 A
%I-%;l d 2

m

HO|2| = AFEAt7t AdElst S A0 Thet As22 YEIt 2| Y LT U8 7hsT EH AL F

23
=412l 24 2Z0ol| Tef ety

rr »N

qu

IAR Embedded Workbench 2HHEZ 35}17| 2|5HAM = E}Zl &
ot =S FE Lt A45l0fF o= =2 Ofeff Het 2o, 0|l T4 5Lt

EH
=

iz

Ao

[ ]
T

C EH
=— d

IAR Embedded Workbench IDE & x| ZZ ex. C:\Program Files (x86)\IAR

ide_directory_path
Systems\Embedded Workbench 8.4

project_file_path  IAR Embedded Workbench T2 E I} (.ewp) A=

9l B2 24517 Rat1 EIZL 812 MY Ho|R|Q o2 HES 2 FPL FRIt HAE UL EAE Y
HIAO[E|S) Z2HE 01RA S22 > 54 > B EHIAE > BN BF0IN CH 23 & UL
B 23 Y2 0fXD RU EIAE Ho| A% BES 23 Controller TesterdlAl E2 E|AE ICS wEH

ofe stdio.h 9| 10 &4 A2 A| 2l0|E22{2| A% #iZo| LeFtc

-?—43&111|O|A0| T=zHE 222l -> Options -> General Options -> Library Configuration ->
Library tab 2 Full2 HZAgL|C}.
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Options for node "test”

Categary
General Optons
Static Analysis
Runtime Checking
CfC++ Compiler
Ass=mbler
Output Converter
Custom Build
Buid Actions
Lirker
Debugger
Simulator
CADI
CMSIS DAP
GDB Server
Ijet
Minkf])-Trace
T1 Stellaris
Mu-Link
PE micro
STAINK
Third-Party Driver
TIMSPFET
TI1XDS

Library Options 2
Target Output
Library: _

Ful v

Configuration file

MISRA-C:1998
Library Options 1

MISRA-C:2004
| Library Configuration |

Description:

Use the full configuration of the C/C++ runtime
library. Full loczale interface, C locale, file
descriptor support, multibytes In printf and scanf,
and hex floats in strtod.

STOOLKIT_DIR$Winc#cwDLib_Config_Fullh

(L] Enable thread support in library

Library low-level interface implementation CMSIS
None stdout/stderr
© v Use CMSIS
(O Semihosted Via semihosting
) ] DSP library
() IR breakpoint Via SWO
ok | Cancel
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3.2. Texas Instruments CodeComposer, all

versions

m

§|_|.7-C_>| A2

rr oy

0| 2| =
_|

qu

Code Composer Studio

F5 UL 2830 st 3*3

ol

o
-

A EH

—

=3 7t
=42 24 240 [Efaf =ty

= Ao thet A=

—_

7] M= EFAL
2 Hof 42, 0]

o2 Huot HYLICH Meh IHsE Ol Ao &

B costest =2 ) X
HEH WAE g2 D B BAE 4F AL HAE SEF GERUL +SLE A B2EF TFS. L 2 TR B PRE UESI0 HELE B HAEE S AsUD - v v
5 My
ue b T F C2000 ¢ 62 0 TMS320F2BX b i EtZ 23 7 He 7
v Bl §i=E EE:
E“AEZ’ w2 g5 | O¥c23ucxs
ue o s
= use_stdio_header false
7|Et use_std_string_header falze
Ide_directory_path Cwtivccs920
workspace D:#¥ccs_workspace
project_name 12.7est
toolchain_kind ti
oE:
2%
T8 F 7 L Ed
HIC EH
== g

ide_directory_path Code Composer Studiol| C|2E2| AZ ex.C:\ti\ccs930

workspace Code Composer Studiol| LI A O|A ClAHAER] A=

project_name Controller Tester0| M 24st Code Composer Studio Z2XE 0|&

[

HIAO|E{Q] Z2ME OIRA 222 -> EA -> E}Z HAE

=

?l #2224t 2ot 2 27 4 HO|AS $ HES £ B2 AR} HFE FRolE HAE
E > El7I 2 o)

=
20 B0 CHA 238 4 UBLCE

BRI 2t3 43S 03| FU HAE Fof M3l HHES +2T Controller TesterOf| A EtZU E|AE REZS HUEF
L|C}.
! Al 2HH0f| A Code Composer Studio?} AE|0f QO H AL of 217} EHAEHL|Ct.
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3.3. CodeWarrior IDE

Etal 2t8 2 HO|A|= AHEAt dElst S A0 Whet As22 YEIH 2| Y LT U8 7hse EH AL S
Fc 242 =24 2H0l| Tef FetyL

iz
N
U
=2
>
ne
x0)
rol
ox
HT
un
njo
1o
il
_o'ﬂ
[
re
Hu
i
qr
o
°
a

CodeWarrior 2eE & 57| fIsiMe= EFA &HE AH 9] =t
2 Joli0F 5h= ¥ Z2 Ofefl ot 220, Ol B4 =Y UL

e HIC EH
=— d

CodeWarrior IDE Ax| A= ex. C:\Program Files (x86)\Freescale\CW for

ide_directory_path
MPC55xx and MPC56xx 2.10, C:\Freescale\CW MCU

ide_version IDE &, Classic &= Eclipse

0=

Classicl| 42 T2 HME /M Al HHSE .mcp ItY, Eclipsel| 22 T2 E

roject_file_path
project_file_p A Al B+50{2l .project It

¢l S=ES AP5HA ot B2l & F Y HO|R[2] »=E HES +E L F=ItH
> Et2l 2H30IM THA 28

4
-

A o
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3.4. Hightec Development Platform IDE

| &d 28 HO[R|= AFEAI7} HEiSE S| 010l Tet Ats22 YEIT A YL e Thstet T A2l &

5
o
Fc 242 =24 2H0l| Tef FetyL

Hightec IDE WEE 57| QlafAli EI 817 B30 WE SOl s Y= E2 Yoisin ¢S FEUC %
g3liOF Stz =2 o2l et 220, Ol= B4 3Lt
e HIC EH
=2— dJ
ide_directory_path Hightec IDE 22| B2 ex. C:\HIGHTEC\toolchains\arm\v4.6.5.0

project_directory_path HighTec IDEO||A] M/HSt T2 ME C|2E{2|Q] B2
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3.5. Tasking VX IDE

EF2 817 4% T0| 2| AFS A} MeEt SH 210 W2t SO R HEIt HAYLICL Mel 58 Cibie] 3
2E SH9l BN 23| mat gLt
Tasking VX IDE IEE 517| QIsAE B B3 3| UC S04 Lo FHES Y2A5in Y=E 5L

[=]
Ct. 2{43l{0F of= =2 Ofefl Eot 22, Ol B4 5L

oo U

« HIC EH

=2— d
ide_version A 2| %=l Tasking VX IDES| A
makefile_path Tasking Z=2 M E0f 244 =l makefileQ| H=2

Tasking VX IDE7t A x| &l ClAIE2| A2 ex. C:\Program Files

ide_directory_path
(x86)\TASKING\C166-VX v3.1r2

9 =S 49 A g Ho[R[o] 2R HES & 4L 427 HEE 40 = HAE U
HIZO[E{ o] Z2HE OtRA 238 > 54 -> EfZ HIAE > BRIl SF0[M CHA| 288 + AS LT

Ef2 817 42 0121 QU BIAE Ho| A% H{ES 28 Controller Testerd|A] 2 BIAE BEE WC
L|C}.
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3.6. Renesas CS+ IDE

m

&3 2438 HojR=

rr »N

qu

=

Renesas CS+ IDE
L|C}. 24 35HOF St=

=1
=
St
[=]

e HIC EH
=— d

ide_directory_path

ide_kind

workspace_path

23 ARt e = A
=412l 24 2Z0ol| Tef ety

S2 57| SIshME B 2
22 of2f Eet Zo0i, 0l T4 F2YLC

Q0] Tet Ats 2= YEIT A Y LT e Thstet TH A2l &

e
N
iz
2
>
ne
x0)
ro
ox
HT
uin
njo
1o
il
_o'ﬂ
[
re
HU
i
qr
o

Renesas CS+ & xz| C|2E2| AZ ex. C:\Program Files (x86)\Renesas
Electronics

IDE 22(CS+)

Renesas HEW IDEQ| 20 T 35lB2 =2,

project_file_path

O
o
>
=
=
S
o)
=
_|
o)
n
28
)
-
=2
R
m
>

«%s Controller Tester0O| M E|AE _?_E%%
E|-7| |:_-||/\E :H:E HI: |.7|
RoteE M4 oHO|: o,:,H_| ct.

- Build Tool2| Property -> Compile Options -> Preprocess -> Additional include paths O
M ofeiel A2 7t

(CTWORKSPACE) \.metadata\.plugins\com.codescroll.ut.embedded\ CT project name
\TestFixture

(CTWORKSPACE) \.metadata\.plugins\com.codescroll.ut.embedded\ CT project name
\TestFixture\cs

=ECELEEE

g
_I_
rr
A
o =
=)
()
(%2}
Q
(72}
(@)
CD
+
)
Hu
2
Im
2
=P
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@ .
o S IR - -
RS ot A0S - i B esiak AT FAE T
. !
"
1 & =8
[ =]
mdrrred by wsbe
e P L i i i e i R A S P i e B Bt Bt
| I L T = L [ e =y e ey =
= i
E..M. i wap
M e
e L - [P -:. . " - Vo e - e .
¢
Fath Edit x

Fath(One path per one lin): 14

Y'com codescroll ut embedded W RenesasCSPlusRLTE_2'W Test Fisture
¥com codescroll ut. embedded WhRenesasCSPlusRL7E W Test Fixturetes|

Browse...

[ ] Permit non-existent path

Include subfolders automatically
Placeholder:

Placehalder Value 2

ActiveProject Dir C:iUses WSUREW Documents™WTEST
ActiveProjectMame  TEST

BuildMadeMame Default Build

MainPraject Dir CAUsesWSUREW Documents™WTEST
MainProjectMame  TEST W
£ >

OK || Cancel || Heb
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3.7. MPLAB X IDE

EFX £17 417 H0|2) = AFB2P7} AeEt SAQl0) wef RIS 02 It MAUYLICH Mel Jhsdt Cluizie) £
S S0 24 M| Kt ZryLch

MPLAB X IDE Y= 2 57| 9lafiAl EI2l 8% M¥o| U= QoM LRst 2SS Ysin #=E S5t
2L A3iof s B2 o2l Bef 2oni, 0l T4 YLt

MPLAB X IDE &x| AZ ex. C:\Program Files (x86)\Microchip\

ide_directory_path
MPLABX\v5.35

project_directory_path MPLAB X IDEO||M 45t ZT2HE C|2lE 2| B2

¢l =S 2gstA| Zoti EfZl 2F 2y TO[R[2] = HES =2 U d27I HEE dR0= HAE Y
HIZO[E{ o] Z2HE OteA 23 -> 54 -> EfZ HAE > EfZl F0M THA| 28 + UASUT
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3.8. Microsoft Visual Studio

23 28 H O[] = AFEAR7E dEfeh SA|Ql0f Tt At 22 FEIF 2 HUCH U8 Vhset CHA &

= O °
ol 24 240 tef FefgUch

m

rr »N

=

qu

L

T
i

Microsoft Visual Studio

IS2 517] QIBHAE EF2L 817 Aol U SojH LR YESS YD ¥R
FEUICE 250t st B2 :

o
S Ofef #ef 220, Ol 24 ¢=YUCh

=

o py

e HIC EH
=— d

Microsoft Visual Studio A2| Z=Z ex. C:\Program Files (x86)\Microsoft

ide_directory_path . )
Visual Studio 10.0

build_configuration CH4 &M

sin_path Cia 2240 Y A2 (.sin THY)
9l F2 MR R5H1 EZL B 4 HOR YR HES 2 AU AR HAE A0l HAE Y
BIAO|E{S] T2 HE OIRA 23F8 -> 54 -> EHJ HAE -> BRI &HFO|M CHA| 8 &+ AT
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3.9. GNU Compiler

A0 Thet AAs22 LI YL U8 7hsT CH AL F

Btz 2t8 2 H0|x| = AFEAt dEle
Fc 242 =24 2H0l| Tef FetyL

=— A

GNU Compiler £E 2 5t7] 2JaiM = EI2 82 43o| YT eofl i W5 YR SS Yaistn =S FELCh
24430} St S22 Ofef Het 2o, 0= T4 3

o

makefile_path A7} 2-4 5t makefileQ| A2

¢l =S 2GR Zot EfZl 2F Y TO[R[9] = HES =8 U d27I HEE dR0= HAE Y
HIZ|O|Ee] Z2HE OIA 238 -> £4 -> EtI HIAE > B2l SHF0|M CHA| 28 & UASLICE

Eb 212 4HS 012D R4 BIAE Ho| A3 BES =28 Controller Testeroj|A] E}2 HAE =2 UEF
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4. |:|-E A|-.9.1|-g|. II EZ-IIE -rr°|'7|

Controller Testergj| M Aot T24l

= EE CE At S/ = AL
Controller Tester 3.3 O| &0 M= [Z24A

HEW2], [E2HE Y 27]] 7|52 AHE

l_l_|

ol

FL|C

o Controller Tester 3.3 0|5/ T 2HE 22 A| 7I0|E
« Controller Tester 3.2 0|/ RTV T2 E A2 A| 7{0|E
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4.1. (Controller Tester 3.3 0|$) T2XME 31§
Al 7ol E

Controller Tester 3.3 0|2 BE{= [Z2HME YELY|], [ERHE IHQR7|] 7|SO=2 24| I2UEZ 2

+ AU
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ODZ2AHE JYNEHAEE I

ol Q1 Ol wOll A [EF] > [LHE L[]S 2= CH

u_I.CH(FJ ,qxI(EJ ""M(A] ﬁi;‘“E(P] ga RJ é
ME ZHS7|(N) r
=ile] Ctrl+W
25 220D Chrl+Shift+W
HHEHE) Ctrl+S
BE HENE Ctrl+Shift+5
0| E HHR7| (M) F2
ME J# 7R F5
HSAH 0| B2 (W)

pa THRE7I()...

ey HHELWHAO)..
EHiR) Alt+Enter
EE

ol

5101

[=!

23

Im
iy

L
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